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Clearance Verification
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Clearance Verification

+ Use Clash Detection tool
— Tools > Clash Detection

— Setup by level
symbology or...

* Check all kind of
clearances: horizontal /
vertical

» Works with reference files

« Checks among any 3D
elements
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Quantity and Geometry Reports
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Quantity Reports

* Quantities
— Concrete in v1.0
— Rebar in future versions
— Cost Estimates included
— Unit price in Library

10

Bridge Name: BR 1
Bridge Unit: Unit1 :: Segmental Bridge

&

Materials Quantity Report

Superstructure Quantities

Com:;r;ent Segment Type | Material Name | Material Type Pay Unit Unit Price Quantity Cost
Expansion Precast
1 P Segmental Box Concrete Cubic Meter 1200.00 11.54 13842 58
EndBent .
Girders B
2 Closure Deck Concrete Concrete Cubic Meter 850.00 8.28 7041.80
Precast
3 3 Segmental Box Concrete Cubic Meter 1230.00 2595 31924 40
Girders A
Precast
4 4 Segmental Box Concrete Cubic Meter 1230.00 2595 31924 40
Girders A
Precast
5 5 Segmental Box Concrete Cubic Meter 1230.00 2595 31924 40

Girders A

D, L
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Geometry Reports

Echo input report

— Review your data entry.

Deck Elevations

— Flexible reporting point
options

Beam/Seat Elevations

Support Elevations

Bridge Name: BR 1

Bridge Unit: Unitl :: Segmental Bridge

Deck Elevation Report

Normal to alignment

Alignment TEO1a with offset = -2.0000,0.0000,2.0000
Span 4

Name Station - Bridge Alg(m) | Offset - Bridge Alg(m) Elevation(m) X(m) Y(m)
::2::Closure 5+00.7119 -2.0000 544114 239901.5708 3969219.7443
:2::Closure 5+00.7119 0.0000 544114 239902.7337 3969218.1171
::2::Closure 5+00.7119 2.0000 544114 239903.8966 3969216.4900

3 5+01.1731 -2.0000 544183 239901.9429 3969220.0107
3 5+01.1731 -0.0000 54.4183 239903.1087 3969218.3857
3 5+01.1731 2.0000 544183 239904.2748 3969216.7606
4 5+05.6731 -2.0000 54.4858 239905.5474 39692226452
4 5+05.6731 0.0000 54 4858 239906.7417 3969221.0410

Bentley
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Scheduling and Construction Planning
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Scheduling

1.

Connect the model with Project
Scheduling software.

Add extra field matching the task with the
MicroStation Level Name that will be
constructed in that task.

Save the schedule in XML format.

Open the Animation Producer, and
switch to the Scheduling View

Import the Schedule in the Animator.
Link the level name with the task.

Select Tools > Preview to start the
simulation.

Record the simulation

H Animation Producer

File | Settings Tools View
Mew Script....
Open Script ..
Scale Script...
Copy Script...
Include Script ...
Import M5A File. .

Schedule

Clear Script...
Delete Script..

Record Script...

Continue Recorded Sequence ..

Taone Map BIMG Files. .
Exit

Record Script

Output Fle:
Aspect:

Resolution X:
Resolution Y-

ct Scheduling®data'MaovieSimulation wmv| =}

HDTV (1920 1080)
1920 [
1080 [

Format: | Windows Media (WMV)
Codec: | Windows Media Video 9 ~
Mode: |24 Bit Color -

Bender Mode: | From View (Smooth)
Render Setup:  Untitled
Light Setup: “Ei- From View
Environment Setup: |Untitled
Artialias | Very Low

-

View: |1
Gamma: | 1.70

-

-
-
-
w

-

w
¢

[] Clear Pattem./Bump Maps Between Frames

(®) Record Range:
Begin Time: | Wed, 9/30/2015 08:00:00
End Time: | Thu, 4/21/2016 08:00:00

(") Record Selection:

Times:

[] Eield Rendering

Motion Blur
Stereo

Use Distrbuted Rendering Q
[] Include This Session

QK Cancel

Odd Rows First

-
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1D Name Duration Start Finish

STO0060 | JTelegraph Road |[1189d 27/111/06  |16/08/11 = -

Side by Side Management Report

ZOODOQDOOOSI
Baseline Scenario 1 150000p000S|
V 100000P000S
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LB

Updated Schedule

Baseline
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Intelligent Models
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Publishing I-models

File > Publish i-model

Read only file for information
exchange

No need of additional
applications.

All reference files are
included. Complete package
including mobile.

Open with Bentley Navigator.

Could be open in other
CADD software.

I Aeopek dgriing: VE DG - OpenBeidge L= B
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= = [ r s e & ®
O S a5
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Compreen .
T Sy Seeng e -
B b Bromer e [E==n =
iy g S TCHEFIEEE
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) Ranter Marager
13 Port Couts
B Mot
1 et
| Ees
| Pt
= Bt
My Pt Crgarger
 yr—— .
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o g
LA G N ‘ L a % x |
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i AN Gospak_ K GBM Diataset I TC Breign\00_Bdge_PG_Camplatedd don Package Settings
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§C\Ubnorah ol mabch g Dt sl TamgDume dgn Create a single package
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A Embed Documents:
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LER A Edit Print
15 =5 13
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| sy RO R
g« || Remave intermediate files
IHE e
= Create an i-model | imodel) file
M anmaton -
[ Publish .imodel to Personal Share
B-9- ' o =] & [lapla]slellel e o Z [
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Augmented Model
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Link Construction Documents

~L Bridge Model 03.27-Final.overlay.dgn [3D - V8 DGN] - Bentley Navigator Vi (SELECTseries 4)
Fie Edt Settngs Tools Review Window Help

@ -O -l

Project Explorer = B X

S, Gh X )

=-10) Bridge_Model_03.27-Fina
1 Column Plan

1 Deck Plan

+¢& Elevation @ Pier 24
& Full View

g

[ Preview

& Section @ Pier 23
Bridge_Model_

a4 [ ] 3

T2 Tesks | @ project Expl.. |

Element Selection  » B 1 X

Oz 0~/ 17
P = Q

e

Element Selection > |dentify element 1 STETOEET "

folle s

PV IUEH B E@ - e x

~ X
B(Q 8H BB kDB M

6] Active v

Element Information > aaX

E- R Selection

PN Ecziing - Fiiction Pendulum Bearing

Extended v

Raw Data v

Bearing

Friction Pendulum Bearing
316

514256

Pier

Bearing

Bearing type XYZ

(See Link [1])

(See Link [0])
659587.74N. 815715.24E
West Bound
23 F
5
Manufacturer ABC
6/10/2013
None

Si (See Link [2])
T

~

4

] Sample Bridge Inspeci
F] FP-Bearing_RM Bridge
FA| FP-Bearing pdf

[=]] FP-Bearing2 jpg E

7 ST s

A\
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¢ Fle Edt Settings Tools Review Window Help

L@ - © ~hl2lalelslelzlel: @ ~ @ B A
i X [65943265¢]| Y [815694.76¢]| Z [26.5470

Catelog Type
Catalog Instance Beams
BeamEnd 1 Moment  -175.745 k+t
K| v BeamEnd1Shear  -3009k
B BeamEnd2 Moment 229485 kt
[ Tasks | @ project Expl...| | BeomEnd2Shear 3316k

Beam End Point Pier 24
Y L Beam Length 350.00 ft
— Beam Line Number 5
o
‘:' o/ @ Beam Material Steel Grade 50
4'_“* ' Beam Material Density 0.49 kip per Cu. Rt
2] Beam Name Custom Section

Beam Orientation Vector N 89 5° 56" E

Beam Placement point  Offset 40.00 ft Right
Beam Section Name  Custom Section
Beam Start Point Pier 23

Beam Structural Materia Steel Grade 50
Beam Unit Weight 0.490 kip per Cu. R
Beam Volume (Gross) 802.7368 Cu. Rt
BeamVolume (Net)  802.7368 Cu. Rt
Beam Weight (gross voli 393.3410 kip

Beam Weight (length * u 171.5 kip per Sq. ft
Beam Weight (net volum 393.3410 kip
Element ID 9055

ID | Description Main Longitudinal Member

(G i i
‘Blement Selection > Identfy element to add to set i Mesh, Level: Blement Groups:US_WB_Spd_Steel, Ref: Reviewed | oJ | & | K

&
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Adding Extra Intelligence to the Model

File Home View Annotate Attach Analyze Constraints Utilities Drawing Aids

« Custom data not generated by . | S
: ) B o & 209 G @ %%t BRSO
Bentley deSIQn or mOdellng Attach  Detach Clip %8 Lf? Att%h o 5 ? & Attach Detacf | Attach Dﬁh
SO'I'-twarel Reference Reference Reference B8 B - to Front Q e Ab T T ltem  ltem

Reference I Raster IF] Point Cloud ltem Types
 Adding extra information to the y— - x
elements in the model. e Ut
G@RFE XD AV x
»  Custom library of property items. R I =
Manufacturer Name Type Date/Time

Serial Number Is Array False

° |mp0rt from DG N or DG N Ll B Default Value 5/13/2016 7:49:29 PM

Installer Responsible

Supervisor

« Available as a standard tool in P

4 O Segmental Box

MicroStation CONNECT edition. B3 1D Nome

= Cast Date

« Attach > Attach ltem in the Items
Types group.
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ut View 2, Default
B -ax-idaq FEER SV %6
Use References Dialog List
Use Fence: |Inside
~ ) ~ &5 -~ [ Detautt - 1 Elz]4]s]s]7]e] i x Y
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Adding Extra Intelligence to the Model

« Decide the level of detall in

Pty Ve ]
e e 10
t e e e m e n tS CAGLEANCHCFAGE BEARNG Do 200
. (CASLE ANCHCRAGE BEARING Cbgn 20000
(CA3LE ANCHCRAGE BEARING Thg 05817
ICABLE ANCHCRAGE BOTOF STMNNT PL 03580
ICA3LE AMCHCRAGE F_ANGE Ht 1357
CASLE MCHCRAGEFANGE He 155
CKSLE MCHCRAGEFANGE 218
CHSLE ICHCFAGEFANGE 21
ICABLE ANCHCRAGE F_ANGE LEG 38%
A ICA3LE ANCHCRAGE F_ANGE LEG 3533

IECABLE ANCHORAGE STM MNT PLT T 0.0725
DELTAYZY3 0.3315
DELTAY2 Y3 0.3315
DELTAYZY3 0.2315
DELTA Y2 Ygirder 2.5000
DELTA Y2 Yginder 2.5000
DELTA Y2 Yairder 2.5000
Depth Cffast 0.0000
Dynamics 3D
{GIRDER TOP FLANGE THK 0.1687
Ral /Active ACS Disabled
Sense Distance 1.0000
Sida Off et Mo Offsat
WORK POINT B1 X 1095.0138
WORK POINTB1 Y 51.8B269
WORK POINT B1 Z 136.0347
IWORK POINT B2 X 1095.9378
WORK POINT B2 Y 51.9959

VIORK POINT B3 10844148
VIORKPOINTB3 52662
VIORKPONTB3 5266
VIORK POINTB3 526629

VIORKPONTB3Z 1367

|- e o
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Generate Reports on the Model

[ SHER + - ==
Home  Veew  Amnctile  AMach  Anahre  Coestrents  Ublites
— 2 AERRZE ® &

Measure Measure Measure Redline Reclime Markups

. Sandards Configuee
Dutanie Racut Angle oo Display Off T2 Checker

Standards Checker

Bridge Models - Final.dgn [0 - V8 DGN] - MecroStation - X

 Custom reports in ———
MicroStation CONNECT.

m-Qu- 4000H00 0

-

Uttt

+

« Sorting options -
‘::_CU

« Tables as graphics in e
DGN, or spreadsheets

1 Instalier Revponsible
0 Supervisce
0 Verfication Date

» [l Sarting Fules

. . . - ‘
 Display formatting options. | -

Praperies

Colummn Definition
Properties

Date Time Format

Case

Date Time Format

Beor ingsa

Serial

Instal 1atien Date Marufacturer Home Humoer
Frigay, Way 13. 2016 Kelvin Deorings [Rc. 536481
Frigay. may 13. 2016 Ronkine Beor ings 1nc. 536441

Frigday. Moy 13. Z016 Ronkine Beorings Inc. 536431

Friday: Moy 13. 2016 Ronrine Bear ings Inc. 536491

i

Elernent Sebection > Ideify element to acd to set 1

27

Ingtallar Respansinle Superyisor

Jorm Gienn

Jatn Smitn

John Smith

John 3mith

=| | 1@z ]4]5]s]7] 8| : X [eseersa

Installation Date

Delault)
Wednesday, Seplembes 7, 200!

nlex
MGr i Gh
Alax
Nonr i oh
Alax
Woorich
Alax
Natr i ah

—
)

varificotion Date
S/VA72006 12207100 P

SA14720M6 12:07:08 PM

5/14/2006 12:07:08 PM

5/147,2018 12:07:08 PM

2| @ | 08M Abutment 11 12l=] |® |@

Bentley



Drawing E =1 ~ | 7~ | = Bridge Models - Final.dgn [3D - V8 DGN] - MicroStation
m Home View Annoctate Attach Analyze Constraints Utilities Drawing Aids

Q ; — & * @ A z -/ O = R R = i = P 3 |:| :H: K- £ T
& None OBM_Abutment Q [} @ s o i /D NeA-! —7 C:‘:\ o % = N @- o -
= B ES - |[= - - Explorer Attach Models Level - Element Fence Line Arc Ellipse o Move Copy Rotate Modi Break  Trim _ Create
B = 0 =0 @0 Tools = Display B = Selection % Tools~ B | Tools~ Tools~ Tools+ + * %% ~ % 0= Elemefrz’t Element Multiple V'~ X Region © Q-
Attributes Primary Selection Placement Manipulate Modify Groups =

ut View 2, Default

reR - = A WO EEE R G

> ) ~ &5 ~ [© Detautt -\ 1 Blz]4]s]s]7]e] i x

Y [1301

Element Selection > Identify elementtoaddtoset £ |
.

|| @ 0B At L1 | |2lal sl |e




Construction and Inspection
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Design 3D Models To Asset Inspection

1 p olle aintenance anage A a e elp Type Asset Name Here... B
Main Dashboard © Add Widget
# Report Status Count - Past Year x # Last Accessed Assets Qx “ My Reports Created Per Month x

Asset Name Asset Code
Cable Stayed Bridge csB [ i
Victoria Bridge Victoria Bridge H
Box Beam Bridge Bex Beam Bridge [ &
Rail Bridge Rail Bridge ] 20
Hotman Bridge Hotman Bridge k X

A My Messages (1) x > 3 %,
 Recent Logins Qx
Date Message From Message Title
e Delte | 092013 Administrator, InspectTech Upcoming Mailenance

Demo, Demo 061422013 3.04:14 AM Delete 1113072012 Administrator, InspectTech Upcoming

Demo, Bentley 03/18/2013 10:28:00 PM Delete 101122012 Administrator, InspectTech Upcoming Mait e

Demo, Admin 03/08/2013 3:58:38 PM

Demo, Mobile 02/01/2013 2:03:57 AM




Bridge Construction Inspection

insnﬂc‘ teﬂn Main Collector Maintenance Manager Administration Intenal Help

Type AssetName Here...

Forms Designer

Bridge Construction Inspector Checklist

Bridge Construction Inspector's Checklist

31

PN: [ ]
County:
Federal ProjectNo.: [ ]

Texas State Project No.: |

Department

Bridge Name: |

of Transportation i i
CEIl Bridge Inspection

Representative:

Bridge Identification No.: |

Project Description: |

Activity Verified

Date
Inspected/Verified

Corrective Action
Taken (Y/N)

1. Stationing of all structures

2. Pile lengths documented at each substructure
3. Plans footing elevation

4 Footing position and skew

5. Footing reinforcement size and spacing,
column steel projection

6. Column longitudinal and transverse steel
size and spacing

7. Bridge seat elevation @ exterior beams of
abutments and intermediate supports

8. Concrete cylinder strengths meet contract
minimums for all substructures

9. Deck reinforcement location and size

10. Proper screed rail elevations set

I
1
I

© Copyright 2014 Bentiey Systems, Inc.
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Intelligent Model in Construction

Navigator CONNECT Eridge Models - Alex_Final.imodel

YA - | | B

[E) Miscellaneous

Model

Bridge Models - Alex_Final

Level

Bridee Models - Alex Final - default
[2) Bearing Manufacturer

Manufacturer Name
Rankine Bearings Inc.
Serial Number
536491

Installation Date
5/13/2016 7:49:29 PM
Installer Responsible
John Smith
Supervisor

Alex Mabrich
Verification Date
5/14/2016 12:07:08 PM

[2) Segmental Box
ID Name
5-1
Level: Bridge Models - Alex_Fi Cast Date
Model: Bridge Models - Alex_Final . 5/13/2016 12:07:56 PM

\@ Navigator

CONNECT Edition

Bentley



Mobile Inspection

5|
Structural View. ProjectWise Nawgator Pano

1

Settings
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Summary
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Summary

1. The modelis not just a 3D model...itis an '
intelligent 3D model. —_—

2. Usein all phases of the project, from design ‘ .|
to construction to asset management. B NS

3. Accurate modeling allows:

Clearance Verification

Geometry and quantity reports
Schedule and construction planning
Add extra intelligence to elements
Reports on the model

® o0 o

4. Ecosystem of Bentley solutions...which we
already know and use every day.
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Thank You !
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